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Overview of Q-Box HR1LP Human Respirometry Package:  
  
The Q-Box HR1LP Human Respirometry Package provides the user with all the materials required to 
measure both the metabolic rate (Respiration) of humans as well as lung volumes and capacities 
(Spirometry).  See the appendix for a discussion of respiration and lung parameters.  
  

During respiration measurements, the subject breathes through a face mask or mouth piece 
connected via a disposable bacterial filter to a three-way non-rebreathing valve. On inhale, breath 
by breath inflow is measured by a pneumotach spirometer with a time response of ~5ms. Exhaled 
breath is directed to a mixing bag by the non-rebreathing valve.  Exhaled air is sub-sampled from 
the mixing bag and pumped through the gas analysis system at a known flow rate (measured by 
the Q-G266 Flow Monitor; manually controlled by the Q-G266 valve). The concentration of CO2 
and O2 in the mixed expired breath is measured using a Q-S153 infrared CO2 gas analyzer (IRGA) 
and a fuel cell Q-S102 O2 Analyzer with response times of ~15 sec. Heart rate is also measured with 
a chest belt monitor.  
  

During lung volume measurements, the subject breathes directly through a spirometer via a 
disposable mouthpiece and bacterial filter. The spirometer measures breath flow, the only parameter 
needed for lung volume calculations.   
  

 Analog signals from all of the sensors are converted to digital signals via two LabQuest Mini interfaces (6 
available channels).  Data are displayed, recorded and manipulated on a PC or Macintosh computer using 
Logger Pro software. Changes in breath flow as well as the concentrations of CO2 and O2 in the mixed 
expired breath are monitored in real time for respirometry studies.  The flow and gas concentration data 

can be used to determine O2 consumption (  O2), CO2 production (  CO2) and respiratory 

exchange ratio, (RER=  CO2/  O2). In spirometry investigations, flow data alone can provide respiration 

rate (RR), tidal volume (VT) and minute ventillation (VE).  In addition, lung parameters such as vital 
capacity (VC), forced expiratory volume after 1 sec (FEV1), and peak expiratory flow (PEF) can be 

calculated from breath flow data alone. 

  
The Q-Box HR1LP Human Respirometry Package can be used to investigate human metabolic 
responses to exercise, to different diets and to various concentrations of O2 and CO2 in the gas 
supplied to the subject.  Gas mixtures can be supplied via two large gas bags (supplied with the 
system. Using spirometry, studies of differences in lung volume between individuals of different sizes, 
sex and race may be performed. In addition, lung obstructive disease may be simulated to observe 
the effects of this breathing disorder on lung parameters.  
  

  

Components of Q-Box HR1LP:  
  
Q-S153 CO2 Analyzer (Range:  0-10%)   

  

Q-S102 O2 Analyzer with atmospheric pressure sensor for O2 signal correction (Range:  0-100%)  

  

Drying columns for Q-S153 and Q-S102 with DRIERITE (blue) (3 x Q11784)  

  

CO2 scrubbing column with soda lime (white) (Q13025)  
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Q-G266 Flow Monitor (Range: 0 -1 LPM)   

  

Q-P103 Gas Pump (1 LPM no load)  

  

G122 Two Large Gas Bag (30 Litres)   

  

C610 Integrated Data Acquisition Interface (2x)  

  

C901 Logger Pro Data Acquisition Software  

  

C404 Customized Setup Files  

  

S182 Wireless Exercise Heart Rate Monitor  

G129  Breath Mixing Bags (2x)  

A505 Face Mask (2 Large, 2 Medium Sizes)  

A506-neo Neoprene Holder for Face Mask   

A508 Non-rebreathing Valve; with bacterial filter adapter, spirometer adapter, mixing bag adapter and 2 
valve leaflets (plus 2 extra leaflets) and  valve leaflet insertion tool)  

S184 Spirometer with nose clip and disposable bacterial filter and mouthpieces  

Q-Box Accessory Kit (includes tubing, filters, connectors, wrench for needle valve adjustment, 
screwdriver for CO2 and O2 analyzer calibration)  

Rugged Weather Proof Case  

  

Manual  

  

Individual power supplies for all the sensors (for use in stand-alone mode outside of the Q-Box)  

  

A103 Spirometer Stand (Optional)  

  

A550 Clean-Bor disposable tubing (2x72”) (Optional)  
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Respirometry  
  

Setup Diagram for Respirometry  

Note: thin black lines indicate electrical connections, thick blue lines indicate breath flow, thin blue lines 

indicate breath subsample  

  

 
 

Nafion RH equilibrator 
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Quick Start Up Steps for Respirometry:  

1. Load Logger Pro software onto the computer (follow instructions on pg. 29).    

2. Load C404 customized files onto the computer (follow instructions from pg. 31)  

3. Plug the Q-Box into a power supply   

4. Turn on the pump Q-P103, flow monitor Q-G266, CO2 analyzer Q-S153 and O2 analyzer QS102   

5. Allow the Q-S153 CO2 analyzer to warm up for at least 15 min  

6. Connect two USB cables from the Q-Box frame to the computer via the USB hub provided plug 
USB1 first and USB2 second (should hear two audible sounds as the two interfaces are 
recognized and drivers are loaded).  

7. Open the “Q-Box HR1LP(Resp) Setup” file to start Logger Pro software for Respirometry 
measurements. For lung volume (Spirometry) measurements see pg. 43 for instructions.  The 
following screen will appear.  

 
8. Assign the sensors to appropriate channels on the 2 interfaces as follows:  

a. Ch. 1 LabQuest Mini 1 = Q-S153 CO2 Analyzer  

b. Ch. 2 LabQuest Mini 1 - Q-S102 Pressure (total gas pressure KPa)  

c. Ch. 3 LabQuest Mini 1 = Heart Rate Monitor (auto detected)  

d. Ch. 1 LabQuest Mini 2 = Q-S102 O2 Sensor (O2 KPa)  

e. Ch. 2 LabQuest Mini 2 = Q-G266 Flow Monitor 1LPM  

f. Ch. 3 LabQuest Mini 2 = Spirometer (auto detected)  

Note: Ch. 3 LabQuest Mini 1 automatically recognizes the S182 Heart Rate Monitor and Ch. 3 LabQuest 
Mini 2 automatically recognizes the S184 Spirometer. This configuration of the sensor connections is 
shown in a text box at the bottom of Page 1 in the software.   
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Check the plumbing of the system by gently removing the tray with all the sensors from the 
Q-Box and placing it outside of the box with the back of the sensors facing up.   The system 
should be configured for calibration before it is used in experiments.  

 

 
  

  

Component Set - Up for Calibration    
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g. The gas supply tubing from the gas source (gas bag filled with known CO2 or other 

constant source of CO2) is attached to “in” port on the Q-P103 Gas Pump via a blue 
particulate filter.   

h. The “out” port of the Gas Pump connects to the “in” port of the Q-G266 Flow Monitor.    

i. The “out” port of the Flow Monitor initially (in the calibration mode) connects to the 
“in” port of the Q-S153 CO2 Analyzer via the Drying Column (blue DRIERITE) and a blue 
filter.   

Note that only one drying column needs to be used when the Q-S151 and Q-S102 are used in 

series unless the gas sample is high in moisture. To equilibrate the RH of the sample gas to 

the ambient RH levels and reduce the moisture in the gas stream before it enters the system 

attach the Nafion RH equilibrator tubing to the output of the breath mixing bag before it 

enters the Gas pump. 

j. The “out” port of the Q-S153 CO2 Analyzer connects to the “in” port of the Q-S102 O2 

Analyzer.  

k. Gas vents from the O2 analyzer via the “out” port.    

l. Two blue filters should be placed in the gas line, one before the pump and one before 
the CO2 analyzer, to prevent particulate matter from entering the analyzers.  

9. After initial calibration and check, configure the components for measurements of respiration in 
an open-flow system:  

  

Component Set-Up for Breath Measurements in Open-Flow System with Flow rates of < 650ml/min  

  

 
 

Replace the Gas Source bag in the above calibration setup with the breath mixing 
bag and attach it via the Nafion RH equilibrator tubing and the blue filter to the 
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gas pump. The analyzers then measure a sample of the mixed expired breath 

from the breath mixing bag that has been equilibrated to the ambient RH before 
it is dried further by the drying column.  

    

10. Set the flow rate through the system.  It is recommended that the system be calibrated at the 
same flow rate that is used through the CO2 and O2 analyzers during experiments.  The flow 

through the Q-S153 CO2 and Q-S102 analyzers should not exceed 650 mL/min, or damage to 
the analyzers may result.  A flow of about 200ml/min is recommended for both calibration and 
breath analysis and the system was set at factory to a flow rate around 200ml/min.  

11. If changes to the flow rate need to be made use the single valve on Q-G266 Flow Monitor to 
make these changes.  The needle valves of the gas pump are set during manufacture (restricted 
about 1/3 of the way from fully open) and should not be adjusted when the pump is used with 
the Q-Box system.  Turn the Flow Monitor valve counter clockwise to increase flow or clockwise 

to reduce flow.  Observe the flow in software Page 1 (lower left; Flow meter).  Once the flow is 
adjusted, use the small 8mm wrench provided in the accessory pack to lock the valve to avoid 
accidental changes in flow during experiments.  Note that flow is recorded in software.  The tray 
holding all the sensors can then be placed back in the Q-Box.  

 

12. The Q-G266 Flow Monitor, S182 Heart Rate Monitor and S184 Spirometer are factory calibrated 
and no additional calibrations are required.  The Q-S153 CO2 Analyzer and Q-S102 O2 Analyzer 
are also factory calibrated. The calibration equation is stored in the software when supplied 

with the analyzers.  However, both analyzers should be checked at the start of each day of 

experiments, and if required recalibrated.  Both Analyzers have linear responses and hence 
require only 2 point calibrations.  The first point should be zero and the second point should be 
a standard CO2 and O2 concentration near the upper range at which the analyzer will be used. A 

gas mixture with ~ 5% CO2 and ~16% O2 with a balance of N2 (similar to expired breath) is 
recommended. Such a gas mixture can be supplied by local gas distributors.  

  

13. Check and Calibration of the Q-S153 CO2 analyzer   

a. Set the CO2 analyzer in the 0 – 5% range which is the default for Q-Box HR1LP Package.   

  

  

L ocking nut    Locking nut 
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b. Supply CO2 free-air to the analyzer by attaching the soda lime column (white) to the 

outlet of the Flow Monitor.  Attach the outlet of the soda lime column to the inlet of 
the drying column.  Both the soda lime and drying columns should be in a vertical 

position.  The outlet of the drying column should already be attached to the inlet of 
the CO2 analyzer. Soda lime will scrub the CO2 from the gas before it enters the CO2 
analyzer and provide the zero reading (the first point of the calibration).  

c. From the main menu in LoggerPro Software select Experiment>Calibrate>LabQuest 
Mini 1> QS153 CO2 Analyzer>Calibration Storage.  A dialog box will appear as shown 
below.  Select the calibration storage as “Experiment File”.  This will ensure that the 

calibration coefficients that have been saved for the specific analyzer purchased are 
used and this way the CO2 values displayed on the CO2 analyzer and in the software 
should match. 

    

 

 

 

 

 

 

 

 

 

 

 

d.  When the reading on the CO2 analyzer is stable, use the small screwdriver provided to 
adjust the “CO2 Zero” control on the analyzer to set the analyzer digital display to 0.00 

CO2. Clockwise turns increase the value and anticlockwise turns decrease the value.  The 
reading on the CO2 analyzer display should match the reading in the software on the Q-

S153 meter. 
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e. If the zero reading is highly out of range (by more than 0.06%), or if the maximum or 
minimum position of the “CO2 Zero” has been reached (i.e. turning the control has no 
effect), use the “Coarse Zero” on the back of the instrument to bring zero within range.  
Use the “Coarse Zero” with caution since very small adjustments result in large 

changes, and there is a delay in response to changes in “Coarse Zero”.  Use the Coarse 
Zero to bring the reading close to Zero. Then use the “CO2 Zero” on the front of the 
analyzer to make the final zero adjustment.  If the Coarse Zero adjustment is required, 
first adjust the fine zero to the middle of its range.  Do this by turning the “CO2 Zero” 
potentiometer on the front of the analyzer clockwise or counter-clockwise to the end 

of its range (it will click when this is reached).  Next turn the potentiometer twelve 
complete turns in the opposite direction.  The CO2 Zero control is then centered.  

 

 

f. Remove the soda lime column (white) from the gas lines and attach the “in” port 
of the Q-P103 Gas Pump to a known CO2 concentration (i.e. gas bag with known 
CO2 concentration).  
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g. Wait until the CO2 analyzer shows a steady reading.  If the Q-S153 display does not 

show the concentration of CO2 in the calibration gas, adjust the display using “CO2 
Span” control.  Turning the potentiometer clockwise will increase the reading and 

anticlockwise will reduce the value displayed. 
h. If a significant adjustment had to be made to “CO2 Span”, go back to the zero 

check and ensure the zero reading on the analyzer has not shifted.   
i. If the readings on the Q-S153 digital display are significantly different from those on 

the Q-S153 CO2 meter in the software, first check that the correct range (5%) is still 

selected on the CO2 analyzer and the correct CO2 analyzer (Q-S153 CO2 Analyzer 5%) 
has been selected in the experimental file.  If these are correct and the readings are 

mismatched then proceed to calibration of the CO2 analyzer in the software as 

described below.   

 

Calibration of the CO2 analyzer in the software (to be used only if display readings on the analyzer 
and software readings are significantly different) 

 

a. Supply CO2-free air to the analyzer by attaching the soda lime column to the outlet of the flow 

monitor.  Attach the outlet of the soda lime column to the inlet of the drying column.  Both 

the soda lime and drying columns should be in a vertical position to ensure maximal contact 

of the gas with the particles.  The outlet of the drying column should already be attached to 

the inlet of the CO2 analyzer. Soda lime will scrub CO2 from air and provide the zero reading 

(the first point of the calibration).  

b. From the menu in Logger Pro Software, select Experiment>Calibrate>LabQuest Mini 1>Q-

S153 CO2 Analyzer (5%).  A dialog box will appear as shown below.  Select the calibration 

storage as “Experiment File” so the new calibration is saved with the current file. 

    

 
 

c. Proceed to “Calibrate” in the same window (see below).  Ensure the Current Calibration is 

selected as Q-S153 CO2 Analyzer 5%<Experiment>.   
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d. When the reading on the CO2 analyzer is stable, use the small green screwdriver provided to adjust 

the “CO2 Zero” control on the analyzer (if needed) to set the digital display to read 0.00 CO2. In 

software, enter “Reading 1” as 0 and  click “Keep” 

e. Remove the soda lime column from the gas line. Attach the “in” port of the Q-P103 Gas Pump to a 

gas bag with known CO2 concentration.  

f. If the Q-S153 display does not show the correct concentration of CO2 in the calibration gas, adjust 

the display using the “CO2 Span” control.  When the Q-S153 CO2 display shows the correct CO2 

concentration, enter that concentration as “Reading 2” in software and click “Keep” then “Done”.  

Save the experimental file under a new name so the new calibration is saved with the current file.  

The CO2 readings in Logger Pro software should now be the same as those on the digital display of 

the CO2 analyzer. 

  

2. Check and Calibration of the Q-S102 O2 Analyzer   

Note the Q-S102 analyzer measures partial pressure (kPa) of O2 in a gas and total gas pressure in the 
system.  The partial pressure of O2 will follow atmospheric pressure changes whereas the 
concentration is constant and independent of pressure variation. The analyzer O2 partial pressure 

reading has been corrected in software for changes in total gas pressure to produce O2 (Pcor) 
reading in % units.  These corrected readings (see calculation below) are displayed in the software in 
a meter and in the graph as shown below.    

O2 (Pcor) = ((Q-S102 O2 )/(Q-S102 P))*100  

Q-S102 O2 is the O2 partial pressure, and Q-S102 P is the (total) gas pressure measured in the QS102 

O2 analyzer.   

To check and adjust the calibration of the Q-S102 follow these steps:  

a. Set the O2 analyzer in the 0-25 kPa range this is the default range for measurements of 

respiratory O2 consumption. Ensure the current calibration is selected as Q-S102 O2 Sensor 

25KPa< Computer> then click Done. 
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b. Supply O2 free-gas (e.g. N2) to the analyzer by attaching the O2-free gas source (i.e. gas bag) to 

the “in” port of the Q-P103 gas pump.  As the O2-free gas enters the Q-S102 O2 Analyzer, the 
reading in the software on page 1 - (O2(Pcor)) will decrease towards zero (the first point of the 
calibration).  

c. When the reading in the software (in O2(Pcor) window) is stable, use the small green 
screwdriver provided to adjust the “O2 Zero” control on the analyzer until this meter display in 
the software reads 0.00 O2.  

 

d. Attach the “In” port of the Q-P103 Gas Pump to a source of gas with known O2 concentration 

(i.e. gas bag with a known concentration of O2). Alternatively, dried room air contains 20.95% 
O2.  

  

  



16  

  

e. When the O2 (Pcor) reading in software becomes stable, adjust the “O2 Span” control on the 

analyzer until this reading corresponds to the O2 concentration supplied to the analyzer.   
 

 

f. If a significant adjustment had to be made to “O2 Span”, return to the zero check and ensure 
that the zero reading on the analyzer has not shifted.  It is not necessary to do the zero check 
while in the calibration mode of the software.  

  

14. The Q-Box HR1LP system is now ready for use in respirometry measurements.  

  

15. Before collecting data with Logger Pro, select Experiment > Data Collection in the main menu.  
The following dialog box will appear:   

  

  

Input experiment length as required.  The default sampling rate is 50 samples/sec and note that 
the rate should not drop below 40 for accurate heart rate data collection.  Note this sampling rate 

  

Total gas pressure  

at the O2 sensor in  

KPa   

O2   concentration  
corrected for  
changes in gas  
pressure ( %)    

O2 reading from  
the Q - S102 in  

KPa   
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is greater than necessary for some of the sensors such as the Q-S153 CO2 Analyzer and Q-S102 O2 

Analyzers which have response times that are much longer than this sample time.  However this 
fast sampling rate is necessary for the spirometer and the heart rate monitor.  Note that with 

longer experiments, the message “Performance may suffer” will appear as the data collection and 
data display may not be well synchronized for "on the fly" visualization.  However, even if the 
display of the data lags collection, the logging of the data proceeds as normal.  Click “Done”.  

Select: File> Save As to save the experiment settings under the file name selected during 
calibrations of Q-S153, so that the original set up file (Q-Box HR1LP(Resp) Setup) is not 

overwritten.  

16. Before starting data collection, three User Parameters must be entered in the software on Page 
1 Raw Data (lower left).  These parameters are ambient temperature in °C (Tamb), atmospheric 
pressure in mmHg (Patm) and ambient relative humidity in % (RH). These parameters are used 

in converting O2 and CO2 to STPD (standard temperature, pressure and dry gas). The default 

values may be altered if local values are known.   These parameters can also be obtained from 
optional sensors (not included in this package).   

 

 

  

17. Attach the mask to the bacterial filter and the 3 way non-rebreathing valve as shown in the 
photos below.   The "In" and "Out" ends of the non-rebreathing valve can be determined by 
briefly blowing  into one of the ends and checking for resistance which is present at the “out” 
end. Connect the spirometer via its “Inlet” end to the “In” end of the 3-way non-rebreathing 
valve using the adapter provided. Attach the Breath Mixing Bag to the “Out” end of the 3-way 

valve via the provided adapter.  The bacterial filter also requires an adapter for attachment to 
the non-rebreathing valve.  
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18. Put on the mask with the 3 way valve assembly, spirometer and breath mixing bag and secure 
it with the head strap as shown in the photos below.  Breathe normally to inflate the mixing 
bag.  During Inhale air will be breathed through the spirometer and during exhale air will enter 
the breath mixing bag.   

  

19. Ensure the spirometer is held upright and still throughout the experiment since tilting may 
affect the readings.  When using the system during exercise an optional spirometer stand 

(A103) and 2 x 72” of Clean-Bor disposable tubing (A550) can be purchased to maintain the 
spirometer at a distance from the subject being measured, and allow the freedom of exercise 

(i.e. during riding a stationary bike).  See photo below for the setup.  
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20. While holding the breath, the spirometer should be zeroed to obtain the base line.  Select from 
the top menu Experiment<Zero and watch the values in the Breath Flow meter (lower right of 

page 1) drop to zero.  A reminder message to zero the Breath Flow (Spirometer) is shown on 

the first page of the software (see below). 

 

21. Start data collection by clicking the green button “Collect” and stop data collection by clicking 
the red button “Stop” (green “collect” turns into red “stop” during data logging)   

 

 

22. At the beginning of an experiment, obtain ~ 30 sec of reference readings for the Q-S153 CO2 

and Q-S102 O2 analyzers before connecting the subsample tube to the Breath Mixing Bag for 
measurements of CO2 and O2 in the expired breath.  To do this, subsample background room 

air through the system while collecting data.  These values will be approximately 0.05% CO2 
and 20.95% O2.  

23. While collecting the CO2 and O2 reference data, hold the breath for a few seconds to check for 
baseline shift in the breath flow, then resume normal breathing.  
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24. Attach the subsample tube between the breath mixing bag and the Q-P103 Gas Pump as shown 

in the Setup Diagram for Respirometry on pg. 6, as well as in the photo below.  

  

  

  

  

  

25. Collect the CO2, O2 and breath flow data from the mixing bag and spirometer for few minutes 
until stable readings are obtained.  The duration of the experiment to obtain all relevant data 
should be 5-10 minutes.  

26. Logger Pro software displays data on Page 1 (Raw Data) as they are collected in graphs, meters 

and table columns.  Sample respiration data is shown below. Note the inverse relationship 
between the O2 and CO2 readings.  The heart rate, as recorded by the heart rate monitor is 
displayed in a separate graph together with the respiration rate (breaths/min) which is 
calculated from the breath flow.  
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27. During the experiment, the x and y axis ranges can be adjusted by clicking on the lowest or 
highest number and typing in the desired new value.  

 

28. Upon completion of the experiment, the data can be analyzed directly in Logger Pro using the 
various analysis tools in the Analyze menu, or using icons selected in the top menu bar.  

Further calculations can be done directly in software on Page 2.  The data can also be directly 
exported as a CSV file (File > Export As > CSC), which can then be opened in any spreadsheet 

program for further analysis and calculations.  

   

Calculations of O2 and CO2  
  

Calculations of O2 consumption ( O2) and CO2 production (  CO2) and Respiratory Exchange Ratio (RER 
= CO2/  O2) are done on page 2 of the software.    
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The user must enter the values in the red columns of the table on Page 2.  These are Avg expired O2 
(%), Avg expired CO2 (%), Ref O2 (%), Ref CO2 (%) and average breath flow.  These values are 
obtained from the raw data on Page 1 using the statistics analysis tool.  These average data can be 
obtained by left clicking the mouse and dragging the cursor to highlight a portion of the data when 
the reference or expired measurements are stable.  Once highlighted, select Analyze<Statistics in the 
menu or the stats icon tool from the icon bar, to obtain the mean values for the parameters of 
interest.  See the software screen below.   
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The mean values from the statistics windows can be copied into the red columns on page 2.  The 

weight of the person also needs to be entered and the calculations of the O2 and CO2 
(converted to STPD) will be done automatically according to the formulas below:  

  

O2 = (Avg Breath Flow*60000*[(Ref O2/100-Avg Expired O2/100)-Avg Expired O2/100*(Avg Expired  
CO2/100-Ref CO2/100))/(1-Avg Expired O2/100)]*[(273)/(273+Tamb)*(Patm-
(RH/100)*exp(20.3865132/(Tamb+273)))/(Patm)]/Weight  
  

CO2 = (Avg Breath Flow*60000*[(Avg Expired CO2/100-Ref CO2/100)-Avg Expired CO2/100*(Ref O2- 
Avg Expired O2/100))/(1-Avg Expired CO2/100)]*[(273)/(273+Tamb)*(Patm-
(RH/100)*exp(20.3865132/(Tamb+273)))/(Patm)]/Weight  
  

Where Tamb is ambient temperature in °C, Patm is atmospheric pressure in mmHg and RH is relative 
humidity.  For most accurate measurements of O2, CO2 and RER, a Haldane correction must be made, 
because, unless the subject is respiring pure carbohydrate (in which the amount of carbon is exactly 
equal to the amount of oxygen), the subject will inhale more gas than is exhaled. This is due to the fact 
that fat and protein are highly reduced compared to carbohydrate, and therefore more O2 is consumed 

during their metabolism than CO2 is produced. As a result, the volume of inhaled breath is typically 
greater than the volume of exhaled breath. Since the respiration package measures only inhaled breath, 
a correction has to be applied for this imbalance as shown in the equations above.  O2 and CO2 
calculated this way will be expressed in units of mL/min.   

  

The above equations are only valid if breath flow rate is measured from inhaled breath.  Other 
equations must be used if breath flow rate is measured from the exhaled breath.  

  

  

Both O2 and CO2 are corrected to standard temperature, pressure and dry gas (STPD; 0 °C, 760 
mm Hg, 0% RH).  For these conversions to be correct, the user parameters (Tamb, Patm, RH) on 
Page 1 need to be entered if different from the default values.  The software also calculates the 
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ratio of CO2 to O2, which is the respiratory exchange rate RER.  The average breath flow as 

measured by the spirometer, is used in calculation of the minute ventilation (VE) in L/min and is 
corrected to BTPS (body temperature, ambient pressure and saturated with water vapour) as per 
equation below:  

  
VE = Avg Breath Flow*[(273+37)/(273+Tamb)*(Patm-(RH/100)*exp(20.386-5132/(Tamb+273)))/(Patm47.06)]  
   

See the appendix at the end of the manual for more information on the respirometry measurements.  

  

G129 Breath Mixing Bags  
  
The breath mixing bags have an approximate capacity of 15L and are designed to be reused many times. 
They are made from a gas-impermeable, nylon-polyethylene laminate and are heat-sealed. The openings 
in each bag are large enough to accommodate a tapered connector secured to the bag with a NYLON TIE 
positioned in the groove on the fitting. Connect the outlet of the non-rebreathing valve to the connector 

in the Breath Mixing Bag. Ensure that the bag does not become twisted during an experiment, at the 
point where the fitting is inserted.  This may cause restriction to breath flow.  

  

The other end of the Breath Mixing Volume Bag, has the second tapered fitting.  A 1-way valve fits over 
this connector. This overflow 1-way valve ensures that the bag does not overinflate. Excess breath is 
released but no outside air can enter the bag.  Breathe into the valve to ensure it is installed correctly.  

  

  
  

The breath mixing bags also contain a valve with a luer lock connector for the sub-sampling tubing that is 
attached to the Q-P103 gas pump which delivers a subsample of mixed expired breath to the CO2 and O2 
analyzers.  
  

Using the Drying Column and Soda Lime Column  
  
The Q-S153 and Q-S102 are designed to analyze dry gas samples.  Three desiccant columns (short blue 
column) are provided with the package.  These are  filled with DRIERITE to dry the gas before analysis.  
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The column is supplied ready for use.  One column should be mounted vertically on the back of the 
QS153. For very wet samples a second column can be installed in a series with the first one.   

  

DRIERITE contains an indicator that is blue when the column is functional and pink when the DRIERITE is 
spent.  When spent, the DRIERITE should be replaced or reconditioned.  To recondition, remove the 
DRIERITE from the column and place it in a drying oven at 210oC for 1 hour, or until the pink coloration 
disappears.  The replacement DRIERITE is #8 mesh, order #23005 from drierite.com.   

  

  

During calibration of the Q-S153 CO2 Analyzer, CO2 free gas is provided by pumping air through a 
column containing soda lime (Long column with white chemical).  A small amount of poly-wool should 
be placed towards the outlet of the column, and the column should then be filled with soda lime using a 
spatula.  When the column is full, it should be tapped on the desk to settle the soda lime, and then 
topped off with another wool plug.   The soda lime column should be used in a VERTICAL position.  

  

The soda lime provided with the Q-S153 has a coloured indicator to show when it is spent.  The soda 
lime should be replaced when most of it has changed from its original white colour to a pale purple.  

This colour change is subtle, and the purple coloration often does not persist, but appears as a band in 
the column at the junction between active and inactive soda lime.  Replacement supplies may be 
obtained from Fisher Scientific (product #S200I-3).  

  

Note: remove the soda lime column from the system once calibration has been completed.  

  

Warning: Soda lime can cause severe burns.  Users should read and comply with the Material Safety Data 

Sheet on soda lime.  

  

  

S182 Wireless Exercise Heart Rate Monitor  
  

  
The wireless heart rate monitor is designed for use with a strap and a receiver module that plugs into 

the Labquest Mini data interface.  The heart rate monitor does not require any calibration, and when 
plugged into the data interface, will be auto-detected.  The heart rate monitor provides heart rate data 
that is complementary to the respiratory data.  To use the wireless heart rate monitor, attach the elastic 

strap to one end of the transmitter belt. Apply the saline solution to the rubber portion of the monitor 
that comes in contact with the chest and Place the belt against the subject’s chest, in the position shown 

in the diagram below.  Secure the other end of the elastic strap to the transmitter belt. Adjust the elastic 
strap so that the belt lies snugly against the chest.   
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Ensure that the receiver is kept at least 40 cm away from other electrical sources (especially a 

computer!). Interference from other electrical sources will cause readings from the HR Monitor to be 
invalid and sporadic.  

  

The 2 oval grooved areas on the back of the transmitter belt are electrodes. For best contact, wet each 
electrode with 3 drops of saline solution. Plug the BTA connector of the receiver into the Labquest Mini 

data interface and ensure that the subject remains within 90 cm (3 feet) of the receiver. Taking the 
length of the receiver cable into consideration, the subject can be up to 5 feet from the interface. This 
should allow for heart rate monitoring during most types of exercise.  

  

Note that the sampling rate during data collection MUST BE AT LEAST 40 samples/second to achieve 
accurate results. At this sample rate, updating of the tables and graphs will slow down as the 
experiment progresses, however data will still be collected. It is recommended to limit the collection 
time to less than 15 minutes.   

  

 
  

  

  

  

  

  
  
  
  

S184 Spirometer  
  

The S184 Spirometer can be used to perform a variety of tests related to breath flow and lung volume. 
The sensor includes a removable flow head (22 mm ID / 30 mm OD) for easy cleaning and sterilization, 
and a differential pressure transducer. The Spirometer is designed to make human respiratory 

  P O L A R 

  X 
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measurements at rest and during moderate activity.  The spirometer is factory calibrated and does not 
need to be re-calibrated.  It provides accurate measurements at low flow rates.  

  
  

The Spirometer package includes 1 sensor handle, 1 flow head, 5 disposable mouthpieces, 1 disposable 
bacterial filter, and 1 nose clip.   

  

   
  

  

It is important to keep the spirometer in an UPRIGHT position and still during measurements to reduce 

noise measured by the internal differential pressure sensor.   An optional spirometer stand can be 
purchased (A103).  The bottom of the spirometer handle has a threaded hole which may be used to fix 
the spirometer to the stand.  When plugged into the data interface, the spirometer is auto-detected by 

the software. Attach the "In" end of the 3-way non-rebreathing valve to the “inlet” port of the 
spirometer for respiratory measurements.  For spirometry measurements, attach the face mask or the 
mouth piece to the "inlet" of the spirometer via the bacterial filter.    

When making respiration or spirometry measurements, first zero the base line of the spirometer 
without breath flowing through it.  This can be done in the top menu Experiment<Zero.  The Breath 
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Flow meter will then display values close to zero.  Start collecting the data and after a few seconds of 
zero flow (i.e. holding breath), start breathing into the system.    

  

  

A505 Face Masks   
  

Four Face masks are provided with the Q-Box HR1LP Human Respiration Package.  Two large and two 
medium masks are included.  The masks are fitted with an air-cushion for a more comfortable fit.  The 

valve at the top can be depressed with a standard medical syringe tip to adjust the air pressure in the 
cushion. This will permit a custom fit to the face to provide an airtight seal. The neoprene holder 
(A506neo) secures the mask to the face. The mask attaches to the A508 non-rebreathing valve via a 
disposable bacterial filter. The bacterial filter connects to the non-rebreathing valve with an adapter. To 
reduce dead volume, the mask may be replaced by a disposable mouth piece and a noseclip. Face masks 
can be sterilized between measurements with 95% alcohol.  

  
  

  
  

A508 Non-Rebreathing Valve  
  

The non-rebreathing valve is shown below.  The assembly attaches to the bacterial filter with the white 

plastic adapter, whereas the spirometer and mixing bag attach to the T-piece with the clear plastic 
adapters.  The inlet of the valve connects to the spirometer (Inlet side) to measure inhaled breath flow, 
whereas the outlet of the valve is attached to the breath mixing bag to collect exhaled breath.  The valve 
leaflets are visible inside the housing.  The "In" and "Out" ends of the 3 way non-rebreathing valve, can 

be determined by blowing into one side of the valve T.  Since the leaflets act as one-way valves the 
outlet end will be met with resistance to flow from the outside.  
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A507 Valve Leaflet and A509 Valve Leaflet Insertion Tool  
  

The valve leaflets are inserted into the inlet and outlet ports of the valve T-piece housing.  As shown 

below, they can be removed with pliers and reinserted with either a clear adapter or the A509 valve 
leaflet insertion tool.  Ensure the inlet and outlet valves are inserted in the correct orientation to permit 
inhaling through the inlet and exhaling through the outlet.  This can be checked by breathing through 
the white mask adapter.   
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A subject is shown wearing the face mask with the non-rebreathing valve, spirometer and Breath Mixing 
Bag attached.   

  

  
  

  

  

LabQuest Mini Interfaces  
  

The LabQuest Mini interface has 5 independent channels: 3 analog and 2 digital. The digital channels can 
be used with digital control units and other monitors. The analog channels are used to connect the Q-

Box HR1LP sensors.  LabQuest Minis can be used with a PC or Macintosh computer (running Logger Pro 
3 software). Vernier Software of Portland, Oregon, manufactures both the LabQuest Mini and Logger 
Pro software.   

  

   

  

Installing and Running Logger Pro 3  
  

PC Users:  

  

(1) To start, a complete copy of Logger Pro 3 must be installed on the computer.  Before starting the 

installation, make sure all USB cables are disconnected from the computer.  Failure to do so may 
cause an error in the installation of the USB drivers.  

(2) Run the installation and do not change the default destination directory.  Logger Pro 3 will be 
installed in C:/Program Files/Vernier Software/Logger Pro 3.  

(3) The setup process will automatically load the USB drivers for connecting the LabQuest Mini or 
other interfaces to the computer.  
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(4) If QuickTime 6 (or greater) is not installed on the computer, install it when prompted.  QuickTime 

will allow use of the picture and movie features of Logger Pro 3.  

(5) You will be prompted to connect the LabQuest Mini or other interfaces to the computer via the 
USB connection.  The LabQuest Minis can be connected to the computer by connecting the USB1 
and USB2 cables (in that order) from the Q-Box frame into the computer. 

(6) Click ‘Finish’ to complete the installation process.  

(7) Proceed to C404 installation (below) before opening the Logger Pro with the “Q-Box HR1LP (Resp) 
Setup” file.  

(8) Double click the “Q-Box HR1LP (Resp) Setup” file (shortcut copied to the desktop from the C404 
disk) to start Logger Pro and data collection. If Logger Pro detects the two LabQuest Mini 
interfaces, the Logger Pro screen will appear with two stars (icons for LabQuest Minis) in the top 
left corner.  

  

  

 
  

  

(9) If Logger Pro cannot detect the LabQuest Mini Interfaces, a message will appear “no device 
connected”. Or if only one mini is connected then only one star will be shown in the top menu. 
Check that the LabQuest Minis are connected to the computer directly via USB plugs 1 and 2 on 

the frame of the Q-Box.  Check if the USB cables are connected to the minis.  The LED power lights 
on the Minis should be green.  No LED light indicates that power is not supplied to the Minis - 
check power connections.  A red LED indicates that power is on but there is no communication 

between the interfaces and the computer.  In this case, exit the “Q-Box HR1LP (resp) Setup” file 
and unplug the USB cables from the computer.  Reconnect the USB cables with USB1 connected 
first and USB2 second.  This order is important as the computer will assign the LabQuest Minis as 

1 or 2 according to the order in which they were connected. Allow the computer to recognize the 
Minis (bell tone) and then re-open the “Q-Box HR1LP (Resp)  Setup” file.  

  

  

 
  

  

Macintosh Users:  
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(1) To start, a complete copy of Logger Pro 3 must be installed on the computer (You must be using at 

least OS 9.2).  Run the “Complete Installation” and ensure all TI GRAPH_LINK and USB cables are 
disconnected . The most recent version of Logger Pro (3) is included with this package. The 

following instructions are the same as those for PC users.  
  

  

  

C404 Custom Setup Files Installation:  

  
Qubit Systems’ C404 Custom Setup Files disk contains Experiment files (designed by Qubit Systems) for this 

package these are “Q-Box HR1LP (Resp) Setup” and “Q-Box HR1LP (Spiro) Setup” files plus two image files (“F-

V Loop” and “V-t plot”) that need to be copied to the same folder as the setup files as they are used on page 3 

of  “Q-Box HR1LP (Spiro) Setup” file to define and illustrate some of the lung parameters.  The C404 disk also 

contains the manual for this package and the manual for the LabQuest mini data interface.  These files can be 

copied to user specified location on the computer and the experimental file of interest.  “Q-Box HR1LP (Resp) 

Setup” and “Q-Box HR1LP (Spiro) Setup” should be placed in an accessible location or have a shortcut created 

on the desktop to the file.  We highly recommend for the user to make a copy of the original file and keep it in 

a safe place on the computer in case the original is accidentally altered.  

 

Using the Q-S153 CO2 Analyzer   
  
The Q-S153 CO2 Analyzer is a non-dispersive infrared gas analyzer (NDIR IRGA).  It has a gas “in” port 
with a female luer-lock connector and a gas “out” port with a male luer-lock connector.  A length of  
tygon tubing  with a luer-lock connector is provided to join the Q-S153 to the rest of the gas exchange 
system.  The gas supplied to the IRGA passes through a sealed wave guide and vents from the “out” 
port.  The Q-S153 can be used as a stand-alone analyzer in an open or closed-circuit gas exchange 
system. It can be used with other gas analyzers downstream.  However, ensure that the placement of an 
analyzer or instrument downstream from the Q-S153 does not cause a significant increase in 
backpressure.  Increasing pressure significantly beyond that at which the IRGA was calibrated, produces 
erroneously high readings.  

The maximum flow rate of gas into the Q-S153 should not exceed 650 mL/min. This, or lower flow 

rates, should be provided by the Q-P103 Gas pump and monitored by the Q-G266 Flow Monitor.  It is 
recommended that the user calibrate the Q-S153 at the flow rate intended to be used during the 
experiments.   

Gases entering the Q-S153 must be clean and dry, since particulate matter may absorb infrared light and 
cause erroneous readings.  Water vapour will not interfere with the IR absorption measurement of CO2, 

but water vapour will dilute the CO2 concentration.    The Q-S153 CO2 analyzer is supplied with a drying 
column containing DRIERITE.  This drying agent removes moisture from the analysis gas before it enters 

the CO2 analyzer.  Wool plugs at the base and top of the column prevent particulate matter from leaving 
the column.   

The Q-S153 CO2 Analyzer requires 12 Volts DC power to operate. A 120/220 AC power adaptor 

(included) provides 12 Volts DC.  For continuous use, leave the Q-S153 CO2 analyzer powered all the 
time.  Keeping the Q-S153 powered up will maintain the calibration longer.  

  

Caution:  Use only a 12 VDC adapter with the correct AC line voltages.  A 120/220 VAC 50/60 Hz 

to 12 VDC adapter is supplied by QUBIT SYSTEMS.    
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The Q-S153 requires a 2 to 3 minute warm-up period before the CO2 level will be displayed.  During 
warm-up, the LCD will flash numbers briefly and display the number 1.  After the unit has warmed up, 

the LCD will display a very high reading, which will slowly decline to the CO2 level in the supplied gas 
stream.   

For most accurate and stable readings, it is recommended that the Q-S153 be warmed up for minimum 

of 15 min to 1 hour before use.  If the Q-S153 is to be used on a regular basis, it should be powered 
continuously.  

  

Altitude and Barometric Pressure Correction  

  

The Q-S153 is factory calibrated at sea level.  When using the IRGA at elevations other than sea 

level, calibrate at the elevation at which the analyzer will be used.  If this is not possible, correct 

the CO2 reading of the analyzer according to the table below.  For example, when using a 

factory-calibrated unit at an altitude of 2,500 feet, multiply the displayed CO2 reading by 89% 

(1,000 ppm x 0.89 = 890 ppm actual).    
  

  

Altitude (feet)  Pressure  

(inches Hg)  

Pressure 

(mm Hg)  

Pressure 

(psia)  

% Display  

Reading  

0 sea level  29.92  759.78  14.70  100  

500  29.38  746.04  14.43  97.97  

1000  28.86  732.84  14.18  95.94  

1500  28.34  719.64  13.92  93.91  

2000  27.82  706.43  13.66  91.88  

2500  27.32  693.73  13.42  89.84  

3000  26.82  681.04  13.17  87.81  

3500  26.32  668.34  12.93  85.78  

4000  25.82  655.65  12.68  83.75  

4500  25.36  643.96  12.46  81.72  

5000  24.90  632.28  12.23  79.69  

  

For other altitudes, use the following equation:  

  

Percentage of measured CO2 = [1- (4.06234 x 10-5 x Altitude in feet)] x 100  
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Troubleshooting the Q-S153:  
  

The LCD display will not stabilize during operation:  

This may indicate that the unit is not getting power.  Unplug the power cord from the unit and measure 
the DC voltage at the plug; it should be 12 Volts DC.  If using an alternate DC power source, the unit will 
operate with 12 to 19 Volts DC.  If the provided power supply is not supplying 12 Volts DC, contact QUBIT 

SYSTEMS.  

  

Insufficient power may cause a “1” to appear on the display:  

Check that the power supply is properly connected and is delivering +12 Volts (Centre Positive).  Check 
that the unit has been sufficiently warmed up.  

  

Span or zero out of range may cause “1” to appear on the display:  

Turn the “CO2 Span” all the way down (counter clockwise) and use the “Coarse Zero” on the back of the 

CO2 analyzer to display 0 with zero CO2 gas flowing through the system.  Once the zero display is read, 
attach a known CO2 concentration to the system and use “CO2 Span” to adjust the display on the CO2 

analyzer to the correct CO2 concentration.  Return to the zero CO2 check with zero CO2 gas running 
through the system, and if necessary, make small adjustments with the “CO2 Zero”.  

  

Ensure no material (liquid or dust) has entered the analyzer:  

If material has entered the analyzer, it will block the internal light path and “1” will be shown on the 
display.  The unit will need to be returned to QUBIT Systems for repair.  

  

Ensure the Gas Flow Path in the Analyzer is Open:  

Check that there are no internal leaks in the analyzer.  Connect a 10mL syringe to a tube on the ‘OUT 

Port’ of the CO2 analyzer and plug the ‘IN Port’.  Pull a slight vacuum with the syringe.  If there is no leak, 

the plunger should not move.  If there is an internal leak, contact QUBIT Systems for further 
instructions. If the analyzer is exposed to extreme pressures, a leak can result.  

  

Ensure the Pump is not Leaking.  

A faulty pump can leak room air (possible high ppm CO2) and increase the CO2 reading.  To test the 
pump, turn it on and plug the inlet.  Connect a tube to its outlet and place the tube in a glass of water.  
There should be no bubbles.  If there are bubbles, the pump is leaking internally and should be repaired 
or replaced.     

  

Ensure the Soda Lime CO2 Scrubbing Column is used to provide Zero CO2 gas to the analyzer:  

Do not confuse the soda lime column with the drying column filled with DRIERITE.  Soda Lime is white, 

whereas DRIERITE is blue.  If the drying column is mistaken as the CO2 scrubbing column, CO2 may enter 

the analyzer since DRIERITE absorbs some CO2, and can release it slowly thereby slowing response 

time.  If unsure of the condition of the Soda Lime in the column, replace it with new Soda Lime or use an 
alternate Zero CO2 source such as pure N2 gas.  

  

Check Calibration  
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If the CO2 Span control has been adjusted without following a full calibration procedure, the analyzer 

must be recalibrated using a zero gas mixture and a gas mixture with a known CO2 level.  See the CO2 
analyzer calibration section of this manual for the correct procedure.  

  

The CO2 readings on the display of Q-S153 are different from those in Logger Pro  

  

If the CO2 values displayed on the Q-S153 CO2 Analyzer are very different from those displayed in the 
Logger Pro file check the following:  first check that the calibration selected in Logger Pro  

(Experiment>calibrate>LabQuest Mini1>CH1 Q-S153 CO2 Analyzer (5%)) matches the range selected on 
the CO2 analyzer (0-5%).  If the ranges are selected correctly, check that the LabQuest Mini interfaces 

have not been reversed (check that values displayed in Logger Pro software for other sensors are 
correct).  If the LabQuest Minis have not been reversed then the CO2 Analyzer requires new calibration.  
Proceed with calibration instructions outlined above on                                                                                                                       
page 13.  If the LabQuest Minis have been reversed, follow the instructions below on pg. 37 on how to 
fix the problem.  

                                                                 

Using the Q-S102 O2 Analyzer  
  
The Q-S102 O2 Analyzer contains an O2 sensor which is a galvanic cell (a lead-oxygen battery) consisting 
of a lead anode, an O2 cathode, and an acid electrolyte.  It also incorporates an O2-permeable Teflon FEP 
membrane with a gold electrode bonded to its surface.  Oxygen diffusing through this membrane is 
reduced electrochemically at the gold electrode.  A resistor and a thermistor (for temperature 
compensating diffusion across the Teflon membrane) are connected between the anode and the 
cathode. The output of the instrument is proportional to the current flowing through the resistor and 

thermistor.  This current is proportional to the partial pressure of O2 in contact with the Teflon FEP 
membrane.  The signal from the oxygen sensor is transmitted to the computer via the LabQuest Mini 
(i.e. Q-S102 O2).  The Q-S102 O2 Analyzer has two analog signal outputs, one for O2 and one for total gas 

pressure at the O2 sensor.  The pressure readings from Q-S102 can only be observed in software and are 
used in correction of the O2 signal in KPa to O2 in % (O2cor).    

 
The galvanic cell is housed in a brass cylinder for greater temperature stability and more stable O2 signal. 
Pressure (Q-S102 P) is measured at the O2 cell and is displayed on page 1 in a meter and a graph.  This 

pressure value is then used in software to convert the partial pressure of O2 (Q-S102 O2) to a 
concentration O2 (Pcor) which is independent of pressure.   
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O2 (Pcor)=((Q-S102 O2)/(Q-S102 P))*100  

  

 

  

 

 

 

 
 

The maximum flow through the Q-S102 O2 analyzer should not exceed 650 ml/min.  The minimum flow 
through the O2 analyzer should not decrease below 5mL/min to avoid local depletion of O2 at the 
membrane of the sensor.  The analyzer should not be exposed to pressures that are above 20 PSIG or 
below 10 PSIG, or the damage to the sensor can result.   The expected life of the O2 Analyzer’s galvanic 

cell is 3 – 5 years.  If it is impossible to adjust the O2 signal amplitude by adjusting the span, a new 
sensor is necessary.  Contact Qubit Systems to obtain the replacement galvanic cell.   

 The Q-S102 is supplied with its own drying column filled with DRIERITE.  When used in series with the 
QS153 CO2 Analyzer, only one drying column is necessary (in front of the Q-S153) unless the sample gas 
is very wet.  When using the Q-S102 in a stand-alone mode, gas should be dried before entering the O2 
Analyzer to avoid dilution by the water vapour. Place the drying column in the bracket mounted on the 
analyzer and connect it to the “in” port via the blue particulate filter (25um). Please check the filter 
frequently to ensure that it is not plugged.  Plugged filters will result in reduced gas flow to the analyzer 
and should be replaced.  
  

Troubleshooting Q-S102 O2 Analyzer  
  

If the O2 signal can no longer be adjusted with the “O2 Span” and the Analyzer has been used for 3-5 
years, the galvanic cell should be replaced.  Contact Qubit Systems for instructions on ordering the new 
cell and on the replacement procedure.  

  

If significant periodic jumps (0.5-1%) in the O2 readings are observed, this may indicate pressure 
damage to the Teflon membrane inside the sensor cell.  If the signal shows unexpected drift, check for 

other damage to the membrane by removing the Q-S102 O2 Analyzer from the Q-Box tray by unscrewing 
the two bolts on the back that hold the analyzer in place.  While monitoring the O2 readings, tilt the 
analyzer 90 degrees.  If there is a large change in the signal following the tilt, the Teflon membrane is 

The pressure corrected concentration is displayed in a me ter and a graph.    
  

  

Total gas pressure  
measured at the  
O2 sensor in KPa   

O2 reading  
from Q - S102 in  

KPa   

Avg. O2 in % corrected  
for Pressure   
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likely damaged.  In case of damage to the membrane, the galvanic cell should be replaced.  Contact 
Qubit Systems for replacement instructions.  

   

If small pulses in the O2 readings are observed when passing a stable O2 gas through the analyzer, this 
may indicate pressure changes in the system resulting from unstable gas delivery.   First, check the 
system for obstructions or restriction in the gas lines.  Second, check the O2 analyzer by unplugging the 

gas supply line from it.  The reading should become stable after detaching the gas supply line.  A stable 
reading when no gas is flowing through the analyzer, indicates that gas delivery to the analyzer is the 
problem.  

    

Unstable gas delivery may be due to the Q-P103 Gas Pump.  In an open-flow system, both needle valves 
on the Q-P103 Gas Pump should be partially restricted (as set at the time of manufacture, about 1/3 
closed from the fully open position) and the flow should be adjusted via the needle valve of the Q-G266 
Flow Monitor.    

  
Using G122 Gas Bags  
  

The heat-sealed, 30 L gas bags are made from a gas-impermeable nylon-polyethylene laminate.  Tygon 
tubing is attached to each bag by a luer-lock fitting.  The fitting on the other end of the tubing attaches 

directly to the fittings on the Q-P103 Gas pump.  These bags can be filled with air from a compressor (or 
another gas mixture) to provide a constant source of CO2 or O2 for calibration. Bags should not be 
overinflated, as this can cause weakening of the seams and eventual leakage.  After use, the bags should 
be fully deflated, preferably by attachment to a vacuum-line or pump.  

  

  

Troubleshooting LabQuest Minis  
  
LabQuest Mini 1 and 2 are switched  

  

If the sensors show unusual values, Logger Pro software may have confused LabQuest Mini 1 with 
LabQuest Mini 2.  To rectify this situation follow these steps:  

  

Close the “Q-Box HR1LP (Resp) Setup” file.  Unplug the two USB cables from the frame of the Q-Box.    
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First, reconnect one cable into the USB 1 outlet on the frame, then plug the second cable into the USB 2 

outlet.  As each LabQuest Mini is recognized by the drivers, there will be an audible beep and the 
indicator LED light on the LabQuest Minis will change from red to orange.  Reopen the “Q-Box HR1LP 

(Resp) Setup” file and proceed to assigning the sensors to appropriate channels on the two LabQuest 
Mini interfaces as follows:  

a. Ch. 1 LabQuest Mini 1 = Q-S153 CO2 Analyzer  

b. Ch. 2 LabQuest Mini 1 - Q-S102 Pressure (total gas pressure)  

c. Ch. 3 LabQuest Mini 1 = Heart Rate Monitor (auto detected)  

d. Ch. 1 LabQuest Mini 2 = Q-S102 O2 Sensor  

e. Ch. 2 LabQuest Mini 2 = Q-G266 Flow Monitor  

f. Ch. 3 LabQuest Mini 2 = Spirometer (auto detected)  

Note: Ch. 3 LabQuest Mini 1 automatically recognizes the S182 Heart Rate Monitor and Ch. 3 LabQuest 
Mini 2 automatically recognizes  the S184 Spirometer. This configuration of the sensor connections is 
shown in a text box at the bottom of Logger Pro Page 1.   

 
  
 

Using Q-G266 Flow Monitor  
The Q-G266 Flow Monitor has been factory calibrated and should not require further calibration.  However, 
if after extended use the flow values appear erroneous, the zero may have drifted.  To reset zero, adjust 

“Flow Zero” on the front of the instrument using the small green screwdriver provided with the package.  

Make this adjustment with no gas running through the system, until a zero flow value is displayed in Logger 
Pro.  Do not accidentally adjust the “Flow Span”.  If “Flow Span” needs adjusting, a calibrated flow 
standard must be used.   
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It is recommended to adjust the flow rate through the Q-Box using the needle valve on the back of the flow 

monitor.  The flow is increased by turning the valve counter clockwise, and decreased by turning it 

clockwise. Once the flow is set, lock the ring on the needle valve with the small wrench.  The data cable 

from the analog output labeled “Flow” is plugged into the data interface and the flow data is displayed in 

the software.   

 

 

 
 

  

Using Q-P103 Gas Pump  
  

The Q-P103 Gas Pump is a 1L/min (no load) pump.  It is used in this Package to carry gas through the 
system.   The Q-P103 Gas Pump is delivered with pre-set pump speed of 0.8L/min as part of the Q-Box 
system, and together with the Flow Monitor it delivers the gas at a flow of about 200mL/min.  The two 
needle valves on the back of the pump are locked in position to maintain this flow of air through the 
system. The flow rate through the system should be adjusted with the needle valve of the Flow Monitor 
Q-G266.    
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If the pump is used in a stand-alone mode and the pump speed needs to be adjusted, it can be done 
with the two needle valves on the back.  To set the flow rate with the gas pump, initially fully open both 
needle valves on the back of the Q-P103 Gas Pump (turn counter-clockwise). Adjust the flow rate down 
to about twice the required rate using the valve beside the pump outlet (“out”).  Second, reduce the 
flow further to the required rate with the needle valve on the Gas Pump across from the “in” gas port 
(see photo below).    

 
Turn the valves on the gas pump clockwise to reduce the flow or counter-clockwise to increase the flow.  

Once the flow is adjusted to the desired rate, use the small wrench provided in the accessory pack to 
lock both valves of the gas pump with the outside nut in place to avoid accidental changes in the flow 

rate during experiments.    

  

    

 

 

  



41  

  

Spirometry  
  

This section of the Q-Box HR1LP Human Respirometry package can be used as a stand-alone 
section when only breath flow is measured.  By performing the vital capacity maneuver 
various lung volume and capacity parameters can be calculated from the breath flow data.   
The set up of the system for Spirometry alone is shown in the diagram below.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Setup Diagram for Spirometry  
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Quick Start Up Steps for Spirometry:   

1. Load Logger Pro software onto the computer (follow instructions on pg. 30).    

2. Load C404 customized setup files (follow instructions from pg. 32)  

3. Plug the Q-BOX into a power supply   

4. Connect USB 1 cable from the Q-Box frame to the computer via the USB hub provided; may 
hear an audible sound as the Labquest Mini interface 1 is recognized and drivers are loaded.  
Note only LabQuest Mini 1 interface is used with Spirometry stand-alone setup.  

5. Open the “Q-Box HR1LP(Spiro) Setup” file to start Logger Pro software.    

Note : Ch. 2 LabQuest Mini 1 automatically recognizes the S184 Spirometer. The Spirometer is 
factory calibrated and no additional calibration is required  

 The following screen (page 1 – Spir Data) will appear. This page contains instructions on 

the left side as well as Breath flow-time, flow-volume and Lung volume-time plots on the 
right side.   

    

  
  
  
  
  

    

Spirometer   

Bacterial filter   

Mouth piece   

Mouth   
Inspire   

Exhale   

hole for stand   

Interface 1   

ch2   

  

Computer   
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6. Before starting to collect data with Logger Pro software, select Experiment > Data Collection 
in the main menu.  The following dialog box will appear:   

  

Input experiment length as required.  The default sampling rate is 50 samples/sec.  Note 
that with longer experiments, the message “Performance may suffer” will appear as the 

data collection and data display may not be well synchronized for on the fly visualization.  
However, even if the display of the data lags collection, the logging of the data proceeds 

as normal.  Click “Done”.  

Select: File> Save As to save the experiment settings under a new file name, so that the original 
set up file (Q-Box HR1LP(Spiro) Setup) is not over-written.  
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7. Before starting data collection, three User Parameters need to be entered in the software on 

Page- 1 Spir Data (bottom left side).  These parameters are ambient temperature in °C (Tamb), 
atmospheric pressure in mmHg (Patm) and ambient relative humidity in % (RH). These 

parameters are used in converting volume to BTPS (body temperature, ambient pressure, fully 
saturated with water vapor). The default values may be altered if local values are known.   
These parameters can also be obtained from external sensors (not included in this package).   

  

  
  

  

  

8. Assemble the Spirometer, bacterial filter and mouthpiece as shown in the photo below.  

  

9. Have subject insert mouthpiece into mouth as shown in the photo below. Use a nose 

clip to force mouth breathing.  
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10. Start data collection by clicking the green button “Collect” and stop data collection by clicking 

the red button “Stop” (green “collect” turns into red “stop” during data logging).   

 
 

11. Ensure that the spirometer is held upright and still throughout the experiment since tilting 

may affect the readings.  While holding the breath, the spirometer should be zeroed to obtain 
the base line.  Select from the top menu Experiment<Zero and watch the values in the Breath 
Flow meter (right hand side bottom of page 1) drop to zero.  A reminder message to zero the 
Breath Flow (Spirometer) is shown on the first page of the software (see below).  

12.  
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Vital Capacity Maneuver  

Many lung and breath parameters can be obtained from breath flow measured by a 

spirometer. See Figures 1, 2 and Table 2 in the Appendix for a full discussion of lung 
parameters.  These parameters can be obtained from the volume-time and flow-volume plots 
produced by a vital capacity (VC) maneuver. The maneuver consists of normal tidal breathing 
followed by a large inhale and immediate forceful expiration (for 6-8 sec) until the lungs are 
completely empty.   

 To perform a VC Maneuver:  

  

- start breath collection on an exhale  

- breathe normally for three or four tidal breaths  

- at the end of a normal exhale, take a large inhale  

- immediately exhale as fast and hard as possible for 6-8 sec  

  

Typical Spirometry data (page 1) for a VC maneuver is shown below.  

 

 

  

Baseline adjustment after data collection  
  

Adjust the FlowOffset by toggling the arrows (or double click and enter value) until the 
baseline of tidal breaths on the volume-time graph is flat.  
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Data with no Flow offset:  

 

  
Data after Flow offset adjustment:  

 
 

 

Reading Differential Volumes and Flows from V-t and F-V Plots  
  

Obtain VT,  IRV, ERV, PEF, PIF and FEV1 values from the V-t and F-V plots on the Raw data (page 
1). Note: (Δx, Δy) can be obtained by holding left tab and dragging cursor across region of interest, 
keeping crosshairs on the data   
  

To assist with identifying VT, IRV etc, definitions of lung parameters and typical V-t and F-V plots 
are presented on Page 3 – Definitions as shown below. Please note that for the FlowVolume 
loop and Lung Volume vs. Time plots to be visible the data file has to reside on the same 
computer where the Q-Box HR1LP(Sprir) Setup file resides together with the two image files (F-
V Loop.jpg and V-t plot.jpg).  these were transferred from the C404 disk at the time of software 
installation.  
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On page 2, the user parameters “Age”, “Height” and “Gender” must be entered to obtain the 
correct predicted values for the subject. These predicted values are presented in the upper 
table on page 2 Calculations.   

 

The prediction equations used in calculations of predicted lung breath flow parameters based on 
age, height and gender are shown on page 4 Predictions.  
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12. The values for VT, IRV etc obtained from page 1 should be entered in the red columns of the 
bottom table on the calculations page (page 2)  shown below. Calculations are automatic in 
the black columns when all input data has been entered.   
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Specifications of Q-S153 CO2 Analyzer  

 Operating principle          Non-dispersive infrared  

 Gas sampling mode          Flowing gas stream, sealed chamber  

 Maximum gas flow rate        650 mL/min  

 Measurement range (LCD display)      0-10 %  

 Analog output, low sensitivity      0-10 %  

 Analog output, high sensitivity      0 -5 %  

 Accuracy (assumes accurate recent calibration)  0.3% of FS  

 Resolution            0.01%  

Repeatability (assumes stable atm press and temp) Better than ±1%  

 Maximum drift (per year)        ±0.5%  

 Response time (@ 250 mL/min; to 95% of final value)  ca. 20 sec  

Warm up time (@ 22oC)        ca. 5 min  

Output (linear) for Low Sensitivity setting    0-5 VDC for 0-10 %  

Output (linear) for High Sensitivity setting    0 -5 VDC for 0-5 %  

Calibration adjustments        Zero and Span  

Operating temperature range      0 to 50oC  

Storage temperature range        -40 to 70oC  

Operating pressure range        ±1.5% local mean pressure  

Humidity range          5 to 95% RH, non-condensing  
              (Recommend drying gas stream)  

Pressure dependence         +0.19% reading per mm Hg  

Power requirements         12 VDC via 120 VAC/60 Hz adapter  

Current requirements         175 mA average, 450 mA peak  

Dimensions (cm)          (H x W x D: 5.5 to 9.5 x 9.5 x 17cm)  

Weight            1kg  

Warranty            1 year limited  
    

Specifications of Q-S102 O2 Analyzer:  

• Operating principle  - Acid Electrolyte, Teflon Diffusion Membrane  

• Detection Range - 0-25% and 0-100 %O2 (Linear)  

• Resolution - ±60 ppm   

• Accuracy ± 0.21% of Full Scale  

• Response Time (90%) - 12 Seconds  

• Life Expectancy of sensor - 3-5 years   

• Easy sensor replacement  

• Influence by Other Gases - Ammonia and Ozone  

• min flow - 5 mL/min  

• max flow - 650 mL/min  

• Built in total gas pressure reading at the sensor (for pressure correction in the software)  

• Pressure Range - 0.5 atm to 1.5 atm  



51  

  

• Pressure Effect - Output voltage changes proportionally   

• Shock Resistant - to 2.7 G  

• Avoid strong vibration  

• Operating Temperature - 5 to 40oC (Effective range)  

• Weight – 1.35 kg  

• Dimensions (cm) – (H x W x D: 5.5 to 9.5 x 9.5 x 17)  

• Output - 0 to 5 volt  

• Power Supply - 12 Volts  

Specifications of S184 Spirometer  

  

Flow Rate          +/-10 L/s  

Dead Space          93 mL  

Nominal Output    

Detachable Flow Head  

    60 µV/(L/s)  

  Dimensions        80.5 mm (diameter) x 101.5 mm (length)  

  Weight        80 g  

  Construction   

Handle  

    clear acrylic plastic   

  Dimensions        127 mm x 23 mm x 35 mm   

  Mass         85 g  

  Construction        black ABS plastic  

Cable Length         1.5 meters  

Default Sampling Rate 

Stored calibration  

    100 samples/s   

Slope           7.1869 (L/s)/V  

Intercept          -17.9672 L/s  
    
  

Appendix  
  

Respirometry:  
  
Basic Respiratory Physiology  

  

In biochemistry, respiration is considered to be the O2-requiring chemical processes in tissues and cells. 
In physiology, the term respiration is used to mean “breathing”. The human respiratory system functions 
to supply O2 to blood, and to eliminate CO2 from the blood. O2 and CO2 diffuse between the air in the 
alveoli and the capillaries, which supply the alveoli. During inspiration, the volume of the thoracic cavity 
increases and air is drawn into the lungs. The increase in volume is caused by the diaphragm, which 
moves downward as it contracts, and by the intercostal muscles, which raise the ribs as they contract, 
thereby increasing the cross-sectional area of the thorax. During expiration, the diaphragm and 
intercostal muscles relax, forcing air out of the lungs. At rest, especially in the supine position, the 
increase in the volume of the plural cavity is largely due to the action of the diaphragm. During exercise, 
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the contraction of the intercostals plays a disproportionately large role in the expansion of the plural 
cavity.  
  

Respiratory Exchange Ratio and Respiratory Quotient  
  

The difference in inhaled and exhaled O2 and CO2 concentrations can be used to calculate the 
respiratory exchange ratio, RER:  

  

  

RER = (CO2 Production)/(O2 Consumption) = CO2/  O2  
  

  

In steady state at rest, this is equivalent to the respiratory quotient (RQ). At rest, the RQ is usually 
between 0.7 and 1.0. It is defined as the number of CO2 molecules produced relative to the number of 
O2 molecules consumed by intermediary metabolism. The body obtains chemical energy and heat from 
carbohydrates, fats and proteins through glycolysis and oxidative phosphorylation in order to do muscle 
work and maintain body temperature. The ratio of these three macromolecules used depends on the 
type of exercise as well as the reserves of carbohydrates in the body.  At rest ~40% of the energy comes 
from carbohydrates and 60% from fats. With increased work the energy production shifts to oxidation of 
carbohydrates, a much faster reaction. Protein is used as an energy source only when the reserves of 
carbohydrates are low such as during starvation or after extreme, prolonged exercise. This can cause 
tissue damage.  
  

Carbohydrate: The oxidation of glucose, a typical carbohydrate, is shown by  

  

 6O2+C6H12O6           6CO2+6H2O          (1)  

  

Equation (1) predicts an RQ=6CO2/6O2=1.  

  

Fatty Acid: The oxidation of palmitic acid, a typical fatty acid, is shown by  

  

          23O2+C16H32O2            16CO2+16H2O          (2)  

  

Equation (2) provides an RQ=16/23=0.7  

  

Thus RQ is directly related to a subject’s diet. As indicated by the above equations, in metabolizing 
carbohydrate alone, the body produces 1 CO2 molecule for every O2 molecule consumed, for an RQ of 
1.0. In metabolizing fat alone, the body produces 0.7 of a CO2 molecule for every O2 molecule consumed, 
for an RQ of 0.7. At rest, the RQ is usually about 0.85, which reflects a balance between fat and glucose 
oxidation. During exercise, the RER increases with the level of exercise intensity. This is due to a 
progressive shift from fat to carbohydrate metabolism. The increase in blood lactate concentration at 
higher levels of exercise leads to an increase in RER that is not related to the type of substrate utilized. 
RER increases because of the CO2 that is produced when the lactate is buffered by sodium bicarbonate. 
In exercise above the lactate threshold, the RER is often greater than one.  
  

The Q-Box HR1LP package measures air volume breathed as well as CO2 and O2 concentrations in the 
mixed expired breath. This provides a measure of oxygen consumption, O2, and carbon dioxide 
produced, CO2, and hence RER= CO2/  O2. Consequently, RER provides a measure of the food 



53  

  

metabolized (carbohydrate/fat ratio) and in turn the energy produced per liter of O2 consumed as shown 
by Table 1. RER has been used to monitor metabolic response in diabetics to pulsatile insulin treatments 
(Hall et al, 1979).  
  

Table 1: Relation Between RER, Energy and Food Source 

 

RER              Energy   % Energy from   % Energy from 

           (kCal/LO2)                   Carbohydrate                                   Fat 

 

0.7   4.69                  0               100 

0.75   4.74              15.6              84.4 

0.80   4.80              33.4              66.6 

0.85   4.86              50.7              49.3 

0.90   4.92              67.5              32.5 

0.96   4.99              84.0              16.0 

1.00   5.05                            100              0 

  

The amount of energy released during food oxidation can be measured with indirect calorimetry by 
using breath measurements to measure O2 consumption. The amount of heat released during food 
oxidation is directly proportional to the amount of O2 consumed, as well as to the type of 
macromolecule being used. The amount of heat produced for each litre of oxygen consumed in the 
metabolism of carbohydrate, fat or protein is slightly different.  The values are 5.0 kCal/L O2, 4.7 kCal/L 
O2, and 4.5 kCal/L O2 for carbohydrate, fat, and protein respectively.  The average value of 4.8 kCal/L O2 
is generally used in calculating metabolic rate; however, it is important that the composition of the 
subject’s diet be taken into consideration.  
  

Cellular Respiration  
  

At lower work levels, most of the energy used for muscle contraction comes from aerobic sources.  

Aerobic respiration involves the oxidation of glucose to pyruvate through a set of chemical reactions 
called aerobic glycolysis. During aerobic glycolysis, energy released from each glucose molecule is stored 
in the conversion of 2 adenosine diphosphate (ADP) molecules into 2 adenosine triphosphate (ATP) 
molecules:  

2ATP  2NADH  2Pyruvate    2pi  2ADP  2NAD  OHC 2
      

6126   

 

The subsequent phosphorylation of the 2 NADH2 yields another 4 – 6 ATP. Pyruvate is oxidized to CO2 
via the chemical reactions of the Tricarboxylic Acid Cycle. The energy released is stored in electron 
carriers such as NAD (nicotinamide adenine dinucleotide) and FAD (flavine adenine dinucleotide). Energy 
is stored through the addition of high-energy electrons to NAD and FAD. This process is called reduction.  
NADH2 and FADH2 later transfer their high-energy electrons to a series of compounds, which comprise 
the electron transport chain. In the electron transport chain, the energy stored in NADH2 and FADH2 is 
used to form 30 more ATP. O2 is the final electron acceptor in the electron transport chain.  
  

The Ventilatory and Lactate Thresholds  
  
Even at rest and during moderate exercise, there is some lactic acid production through anaerobic 
glycolysis. Anaerobic glycolysis does not involve the Tricarboxylic Acid Cycle or the electron transport 
chain. It produces only 2 ATP per glucose molecule, whereas aerobic respiration produces 36 ATP per 
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glucose molecule in muscle cells. As exercise intensity increases, blood lactate levels start to rise 
exponentially. The point at which this occurs is called the lactate threshold or the “onset of blood 
lactate accumulation” (OBLA). This happens in untrained subjects at about 50 - 60% of maximal O2. In 
trained subjects, it occurs at about 65 – 80% of maximal O2.   
  

The lactate threshold is the point at which lactate production exceeds lactate removal from the blood. 
The sudden increase in blood lactate at the threshold does not necessarily indicate O2 deficiency in the 
working muscle. Several other processes contribute to the exponential rise in blood lactate beyond the 
lactate threshold. Increased release of norepinephrine causes the constriction of blood vessels in the 
arterioles of non-working muscles and in the liver, kidneys and adipose tissue. There is a concurrent 
increase in blood flow to the working muscle, and an overall redistribution of blood flow from 
lactateconsuming (gluconeogenic) tissues to lactate-producing tissues. Contraction of the working 
muscles results in the release of Ca2+ from the sarcoplasmic reticulum. This increases the rate of 
glycogenolysis (glycogen breakdown) through the activation of phosphorylase kinase. The release of 
epinephrine and glucagon at high levels of exercise also greatly accelerates glycogenolysis and glycolysis. 
Pyruvate is therefore produced at a rate that exceeds the rate of mitochondrial respiration, so the 
excess pyruvate is converted to lactate. In addition, the recruitment of a larger proportion of fast 
glycolytic muscle fibres at higher levels of exercise, leads to greater anaerobic glycolysis and lactate 
production. (These fibres produce lactic acid when they are recruited to contract, whether O2 is present 
or not.)   
  

There is also an exponential rise in VE at about 50 – 75% of maximal O2. This is known as the 
ventilatory threshold. The accumulation of lactate in the blood after the lactate threshold was once 
thought to be the primary cause of the exponential increase in VE, but it has been shown that VE 
increases exponentially even in subjects who are genetically incapable of producing lactate. Also, there 
can be as much as an 8% difference in the relative work rates at the lactate threshold and at the 
ventilatory threshold in the same subject. The ventilatory threshold is now considered to be an indicator 
of the onset of metabolic acidosis. This acidosis is accompanied by a small increase in PaCO2, which 
results in increased neural output to the respiratory centre as well as increased ventilation.  
  

Basic Cardiovascular Physiology  
  

Heart Rate Response to Exercise  
  
The normal resting heart rate for a non-athlete is about 70 beats per minute (bpm). Athletes can have 
much lower resting heart rates.  

  

Just prior to exercise, there is some anticipatory increase in heart rate. Within seconds of the onset of 
exercise there is a further increase in heart rate due to the withdrawal of parasympathetic stimulation 
(vagal outflow) to the heart followed by increased sympathetic stimulation of the heart. Sympathetic 
nerve fibres reach the heart by means of the cardioaccelerator nerves, which enervate both the 
sinoatrial node and the ventricles. The hormone norepinephrine is released at the ends of these fibres. 
Sympathetic stimulation causes an increase in both heart rate and the force of myocardial contraction. 
The parasympathetic fibres that supply the heart, arise from neurons in the cardiovascular control 
centre in the medulla oblongata. These fibres make up a portion of the vagus nerve. When stimulated, 
these nerve endings release acetylcholine, which causes a decrease in the activity of both the sino-atrial 
and atrioventricular nodes, thus reducing the heart rate. Withdrawal of parasympathetic stimulation 
raises heart rate. The initial, rapid response of heart rate to exercise is thought to be due to central 
command from the cerebral cortex.   
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As the exercise level is raised, there is an increase in sympathetic stimulation to the heart and systemic 
blood vessels, which is proportional to the relative work rate. This causes an increase in heart rate, 
constriction of capacitance vessels in the splanchnic bed and constriction of resistance vessels in the 
kidneys and splanchnic bed. The increased sympathetic stimulation with exercise is caused by central 
command from the cerebral cortex, and by feedback from muscle chemoreceptors, mechano-receptors 
and arterial baroreceptors (pressure sensors).   
  

Change in Blood Distribution with Exercise  

  

During exercise, there is a decrease in systemic vascular resistance that is proportional to the amount of 
exercising muscle mass. The resistance vessels in the exercising muscle dilate rapidly due to the 
increased local concentration of metabolites, which releases the vessels from the influence of the 
sympathetic nerves. Arterial blood pressure is maintained because of the constriction of the resistance 
vessels in the splanchnic bed and the kidneys. Arterial and cardiopulmonary mechanoreceptors prevent 
marked fluctuations in arterial pressure. The active mobilization of blood from the constriction of the 
capacitance vessels and the resistance vessels, together with the passive mobilization of blood from 
arteriolar constriction in non-working areas, ensures the maintenance of an adequate filling pressure for 
the heart, and allows for the maintenance or increase of stroke volume.  
  

    

Response of Stroke Volume to Exercise  
  

Stroke volume (mL/min) is the amount of blood ejected from the ventricles with each beat of the heart. 
The stroke volume of an exercising subject is proportional to the relative work rate until about 40% of 
the subject’s maximal O2, when maximum stroke volume is reached. Stroke volume increases if venous 
return is enhanced , and decreases if average aortic pressure rises.   
  

Response of Cardiac Output to Exercise  
  

Cardiac output (L/min), is the product of heart rate and stroke volume. In exercise, cardiac output is 
increased through greater cardiac activity and augmented return of venous blood from the contracting 
muscles. At work rates higher than 40% of maximal O2, increases in heart rate are responsible for all of 
the subsequent changes in cardiac output.  
  

Blood Pressure  
  

Systolic pressure is the maximal pumping pressure generated by the left ventricle during the contraction 
of the heart; diastolic pressure is the lowest pressure existing in the main arteries of the systemic circuit 
during the resting phase of a cardiac cycle. Blood pressure is reported as systolic pressure / diastolic 
pressure in millimetres of mercury (mmHg). In a normal subject, blood pressure would be approximately 
120/80 mmHg at rest.   
  

Control of Blood Pressure in Exercise  
  

During exercise, there is a dramatic increase in systolic pressure, but little change in diastolic pressure. 
Pressure should return to resting levels within 4 minutes of the end of exercise. Blood pressure rises in 
response to increased blood volume, heart rate, stroke volume, viscosity, and peripheral resistance. 
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Short-term regulation of blood pressure is achieved by the sympathetic nervous system. Increases in 
blood pressure are detected by the aortic and carotid body baroreceptors. These receptors send 
impulses to the cardiovascular control centre, which responds by decreasing sympathetic activity. A 
decrease in sympathetic activity reduces cardiac output and vascular resistance, which lowers blood 
pressure. An increase in sympathetic activity has the opposite effect.   

    

The Effects of Training  
  

Cardiovascular training causes a significant increase in stroke volume at rest and during exercise. 
Therefore, in order to attain a given level of cardiac output, a trained subject requires a lower heart rate 
than an untrained subject. An average subject’s cardiac output in the resting state is 5.6 L/min. For an 
average stroke volume of 80 mL, this corresponds to a heart rate of 70 bpm. In contrast, a heart rate of 
only 60 bpm is required to achieve the same cardiac output with a “trained” resting stroke volume of 93 
mL. Heart rate is also lower in trained subjects because there is an increase in parasympathetic activity 
and a decrease in sympathetic discharge with training. In mild exercise, the heart rate of a trained 
subject may rise to 90 bpm, whereas the heart rate of an untrained subject could reach 120 bpm. For an 
individual subject, there is a linear relationship between heart rate and relative work rate. Other 
adaptations to training include lower systolic and diastolic blood pressure and increased glycogen stores, 
blood volume, total haemoglobin, myocardial contractility, and O2 extraction, as well as more effective 
distribution of blood flow.   
  

At a given level of exercise, a trained subject ventilates less than an untrained subject. This reduces the 
total O2 cost of breathing (The O2 uptake required by the muscles used for breathing). Generally, in 
trained subjects, tidal volume is larger and breathing frequency is reduced. Air remains in the lungs for a 
longer period of time between breaths, so O2 extraction from the air is increased. As a result, the 
exhaled air of trained subjects often contains only 14 – 15% O2 during sub-maximal exercise, whereas 
the exhaled air of untrained subjects may contain 18% O2 at the same work rate.   
  

In examining the differences in exercise response between trained and untrained subjects working at the 
same absolute level of exercise, one must consider that the untrained subjects will be working at a 
higher relative level of exercise than the trained subjects. (They will be working at higher percentages of 
their maximal O2 uptakes.)  The response levels of many physiological variables, such as heart rate and 
breathing frequency, depend on the relative rather than the absolute level of exercise. Lower heart rates 
should be observed in the trained subject at any given absolute level of work. In part, this is due to the 
training-induced increase in stroke volume; however, the difference in response can also be attributed 
to the trained subject working at a lower percentage of his or her maximal O2 than the untrained 
subject. Heart rate and ventilation recovery times for a given absolute level of work tend to be much 
faster in trained subjects than in untrained subjects because the trained subjects are recovering from a 
lower relative level of work.  

  

Spirometry:  
  

Breathing Frequency and Tidal Volume  
  
At rest, about 300 – 500 mL of air enter the lungs with each inspiration. For the average healthy person, 
the breathing frequency at rest is 12 – 15 breaths per minute.   
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Tidal volume, VT, is the volume of air inspired or expired during a breath.  Additional air, called the 
inspiratory reserve volume, IRV, may be inhaled after a resting inspiration.  Likewise, after a tidal 
expiration, further volume called the expiratory reserve volume, ERV, can be expelled from the lungs. 
Even when the ERV is forcefully exhaled, there remains a volume of gas in the lungs, the residual 
volume, RV, which cannot be exhaled. This gas has a high CO2 concentration which has diffused across 
the alveolar membranes in the lung from the blood capillaries. This CO2 is removed by exhaling when 
fresh air is inhaled and mixed with the residual gas.  The residual volume cannot be measured by the 
QBox HR1LP package and requires other methods such as whole body plethysmography or tracer gas 
washout.  During exercise when O2 demand and CO2 production is higher, tidal volumes are increased by 
using the reserve volumes to match the gas exchange at the alveoli to the metabolic demands in the 
muscles.  
  

Figure 1 presents an ideal Flow-Volume loop whereas Figure 2 shows a Volume-Time plot. From these 
graphs, several lung volume parameters and lung capacities can be extracted. The various lung volumes 
and capacities which are defined in Table 2 can be used to diagnose lung diseases (M.R. Miller et al, 
2005). Typical values for healthy lungs are shown in Table 3.   

    

Figure 1: Ideal Flow-Volume Loop for a Healthy Lung   
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Figure 2: Ideal Volume-Time Plot for Lung  

  
 

  
  

  
 

Table 2: Lung Volumes and Capacities 

 

Volumes 

 

Tidal Volume (VT): 

volume of air inspired during normal breathing 

Inspiratory Reserve Volume (IRV): 

volume of gas that can be further inspired after a normal tidal inspiration 

Expiratory Reserve Volume (ERV): 

volume of gas that can be further expired after a normal tidal expiration 

Residual Volume (RV): 

volume of gas remaining in the lung after maximal expiration 

End-Inspiratory Lung Volume (EILV): 

volume of air at the end of a normal inspiration 

End-Expiratory Lung Volume (EELV): 

volume of air at the end of a normal expiration 
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Capacities 

 

Total Lung Capacity (TLC): 

volume of air in the lungs at the end of a maximal expiration; TLC=IRV+VT+ERV+RV 

Vital Capacity (VC): 

maximum volume of gas that can be expired after maximal inspiration;  VC =IRV+VT+ERV which is the limit for 
VT in a healthy lung 

Inspiratory Capacity (IC): 

maximum volume of air that can be inspired from the end of a normal expiration;  IC=IRV+VT which is the 
limit for VT in lungs with respiratory disease 

Functional Residual Capacity (FRC): 

volume of gas remaining in the lungs after a normal tidal expiration; FRC=ERV+RV which is the relaxation 
volume of the respiratory system. 
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Table 3: Typical Healthy Lung Volumes and Breath Parameters  
  

  
Lung  Parameters  

  

  
   

Parameter  Definition          25 yr old  55 yr old  units  
    
  

            6’ male  5’ female   

VC    Vital Capacity          5.4    2.4    L  

FRC    Functional Residual Capacity      4.0    2.2    L  

RV    Residual Volume        1.9    1.4    L  

TLC    Total Lung Capacity        7.3    3.8    L    

FEV1    Forced Expired Volume in one sec    4.4    2.0    L  

FEV1/VC  

  

  
  

  

FEV1/Vital Capacity Ratio      80    75    %  

Resting Ventilation and Gas Transport Parameters  
  

Parameter  
  

Definition          Value   units    

RR    Respiratory frequency       12-16    bpm    

VE    Minute Ventilation        6-8    L/min    

VT    Tidal Volume          0.5     L    

VDanat   Anatomic Dead Space        150-200  mL    

VDanat/VT  Ratio of Dead to Tidal Volume      <0.4    

 O2    Oxygen Consumption        250-300   mL/min  

 CO2    Carbon Dioxide Production      200-250   mL/min  

 RER    Respiratory Exchange Ratio      0.8  

  

(http://courses.washington.edu/hubio541/secure/syllabus/EApp1_RespParameters.pdf)  
  
  

The following table presents linear regression equations for predicting several lung and breath 
parameters based on gender, age and height.   
  

  

  

http://courses.washington.edu/hubio541/secure/syllabus/EApp1_RespParameters.pdf
http://courses.washington.edu/hubio541/secure/syllabus/EApp1_RespParameters.pdf
http://courses.washington.edu/hubio541/secure/syllabus/EApp1_RespParameters.pdf


61  

  

  

  

  

         Predicted Lung, Breath Parameters  
  
Parameter    Unit         Regression Equation  

  

  

          Male        Female  

VC      L    5.76H-0.026A-4.34    4.43H-0.026A-2.89  

FEV1      L    4.30H-0.029A-2.49    3.95H-0.025A-2.60  

PEF      L/s    6.14H-0.043A+0.15    5.50H-0.030A-1.11  

TLC      L    7.99H-7.08      6.60H-5.79  

RV      L    1.31H+0.022A-1.23    1.81A+0.016A-2.00  

FRC      L    2.34H+0.009A-1.09    2.24H+0.001A-1.00  

  

where H=Height (m)  

   A=Age (yrs)  

  

Respiratory Medicine (1994) 88, 165-194   

  

  

  

The following panel of graphs shows the expected deviation from a normal Flow-Volume loop for 
several breathing disorders.  Panel 1 is for normal healthy lungs. Panel 2 is for a normal subject with 
end expiratory curve linearity, which can be seen with ageing. Panel 3 shows moderate airflow 
limitation in a subject with asthma. Panel 4 shows severe airflow limitation in a subject with chronic 
obstructive pulmonary disease. Panel 5 shows variable intra-thoracic upper airway obstruction. Panel 6 
shows variable extra-thoracic upper airway obstruction.  
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Eur Respir J 2005; 26: 319–338  
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Qubit Systems Warranty Information  
  
QUBIT warrants all its instruments to be free from defects in materials or workmanship for a period of 
one year from the date of invoice/shipment from QUBIT.   

  

If at any time within this warranty period the instrument does not function as warranted, return it and 
QUBIT will repair or replace it at no charge. The customer is responsible for shipping and insurance 
charges (for the full product value) to QUBIT.  QUBIT is responsible for shipping and insurance on return 
of the instrument to the customer.      

  

No warranty will apply to any instrument that has been (i) modified, altered, or repaired by persons 
unauthorized by QUBIT; (ii) subjected to misuse, negligence, or accident; (iii) connected, installed, 
adjusted, or used otherwise than in accordance with the instructions supplied by QUBIT.    

  

The warranty is return-to-base only, and does not include on-site repair charges such as labour, travel, 
or other expenses associated with the repair or installation of replacement parts at the customer’s site.   

  

QUBIT repairs or replaces the faulty instruments as quickly as possible; maximum time is one month.   

  

QUBIT will keep spare parts or their adequate substitutes for a period of at least five years.   

  

Returned instruments must be packaged sufficiently so as not to assume any transit damage. If damage 
is caused due to insufficient packaging, the instrument will be treated as an out-of-warranty repair and 
charged as such.  

   

QUBIT also offers out-of-warranty repairs. These are usually returned to the customer on a cash-
ondelivery basis.   

   

Wear & Tear Items are excluded from this warranty. The term Wear & Tear denotes the damage that 
naturally and inevitably occurs as a result of normal use or aging even when an item is used competently 
and with care and proper maintenance.  

  

Return Procedure  
  
Before returning any instrument to QUBIT:   

   

Consult the operating manual or contact Qubit to ensure that the instrument(s) is in fact faulty and has 
not just been set up improperly.  

   

Contact QUBIT before sending anything back.  We will issue an RMA number and provide shipping 
instructions.   QUBIT will refuse any goods that are returned without an RMA number or which are sent 
in a manner outside of QUBIT’S  stipulations.  

  

If you have encountered a program failure, we would need a printed copy of any faults you have seen, 
including how to reproduce them.  Include these in the return package along with your mailing address.   

  

Include a copy of the Invoice on which the product was shipped to you.   
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All returns must be shipped prepaid.  Unpaid packages will not be accepted.   

  

In case of questions contact QUBIT by   

  

E-mail: info@qubitsystems.com,  

  

 by phone: (01)-613 384 1977,  

   

or by fax: (01)-613 384- 9118.  

  


